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Copyright 
 
All rights are reserved.  No part of this document may be reproduced or transmitted in any form or 
means electronic or mechanical including photocopying and recording or by any information 
storage or retrieval system except as may be permitted in writing by Civica Education Pty Ltd.  
  
Application for permission for use of copyright material, including permission to reproduce extracts 
in other published works, shall be made to the publishers.  Full acknowledgement of author, 
publisher and source must be given. 
  
Material is contained in this publication for which publishing permission has been sought and for 
which copyright is acknowledged. Permission to reproduce such material cannot be granted by the 
publishers and application must be made to the copyright holder. 
  
Microsoft, Windows and Excel are registered trademarks of Microsoft Corporation.  Visual 
Components is a trademark of OMNIS Software Limited.  Integris is a trademark of RM Plc. 
  
Because our policy is to improve our products and services continually, we may make changes 
without notice.  We have tried to keep the information in this manual complete and accurate, but 
we cannot be held responsible for the consequences of any errors or omissions. 
  
Your comments are of great value to us in improving our computer systems, publications and 
services. 

 

Intellectual Property  
 
The contents, design, solutions and plans contained in this document represent the intellectual 
property of Civica Education Pty Ltd and its associates. All rights are reserved except as may be 
granted to the addressee in writing by Civica Education. 
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RM Billing Receipts Primary Training Program 
 

Morning Course 

Time Contents 
8.30am Coffee 

9.00am  Overview of RM Billing 

 Receipting Methods 

 Individual Receipts 

 Billing Item Bulk Receipts 

 Charges and Contribution Receipts 

 Printing Receipts 

10.15am  Morning Tea 

10.30am  Receipt Reports 

 Daily Banking 

 Receipt Summary 

 Correcting Errors 

 Processing Refunds  

 Closing a Receipts Batch 

 Unallocated Credit 

 Auto Allocate Unallocated Credit 

 Following up unpaid debt 

 Statements 

 Review activities and questions 

11.45am  Questions 

 

Afternoon Course 

Time Contents 

12.30pm Coffee 

12.45pm  Overview of RM Billing 

 Receipting Methods 

 Individual Receipts 

 Billing Item Bulk Receipts 

 Charges and Contribution Receipts 

 Printing Receipts 

2.15pm  Afternoon Tea 

2.30pm  Receipt Reports 

 Daily Banking 

 Receipt Summary 

 Correcting Errors 

 Processing Refunds  

 Closing a Receipts Batch 

 Unallocated Credit 

 Auto Allocate Unallocated Credit 

 Following up unpaid debt 

 Statements 

 Review activities and questions 

3.45pm  Questions 
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Training Outcomes 
 
At the end of the RM Billing Primary Training Program participants will be able to: 
 

 Create receipt batches 

 Understand and apply the various methods for receipting 

 Issue receipts for students and customers 

 Record bulk student payments 

 Export a receipts batch 

 Reverse a receipt 

 Refund receipts 

 Produce receipt reports 

 Allocate unallocated credit 

 Produce reports for unpaid debt  

 Produce statements 
 
 

TRAINERS USE TRAINING DATA 1 AND RM FINANCE DEMO  
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1 Introduction to the RM Billing Module 
 
RM Billing is a module that is available within Integris.  When the RM Billing module is added, a 
new sidebar called RM Billing appears. 
 
This module allows both students and external customers (companies and/or individuals external 
to the school environment) to be billed for any type of cost.  Students can be billed for subject 
related costs, charges and voluntary contributions, other optional costs, voluntary approved 
requests, camps and excursions etc. Customers can be billed for items such as hire of the school 
hall etc. 
 
Student details and those of their related contacts (e.g. Parent/Guardian 1, Parent/Guardian 2 
etc.), should be accurate within the Administration module before adding the RM Billing module.  
Each student should have one contact nominated as the person who will be responsible for paying 
their fees.  Correspondence generated from RM Billing - such as Charges and Contributions 
Sheets and Statements - will be addressed to the first contact marked for Fees Billing for each 
student in the Administration module. RM Billing will draw on student and contact data held in the 
Administration module. 
 
The RM Billing module can be used in conjunction with the Timetabling module (optional).  Student 
subject preferences from Timetabling are available in RM Billing.  Costs for each subject can be 
entered in RM Billing and students can be billed according to the subjects they have chosen to 
study.  The bulk billing facility enables students to be billed en masse for any other types of costs.  
 
RM Billing supports several methods of receipting (including bulk receipting) and provides a suite 
of useful reports. 
 
RM Billing can also be linked to RM Finance. A set of Billing Codes created in RM Billing provide 
the link to the budget and analysis codes used by the school in RM Finance. Receipts entered in 
RM Billing can be automatically exported to RM Finance against the correct budget and analysis 
codes.  
 
The following diagram illustrates how RM Billing interacts with other Integris modules. 
 

 
 

 

ADMINISTRATION MANAGER 

 

TIMETABLING 

 

RM 

BILLING 

 

RM FINANCE 
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1.1 Logging on to the System 

 

Activity: Logging On 
 

 Double click on the RM Billing Primary Receipting icon on your desktop 
 

 
 

 Type ADMIN into the User Name field 

 Press <Tab> 

 Type keys into the Password field 
 

 
 

 Click on Login, or press <Enter> 
 

Note: In schools, each user has their own user name and password, which enables access 
to particular sections of the software as determined by the school administration. 

It is strongly recommended that you change your password regularly. 
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1.2 The File Menu 

The file menu may be accessed by clicking on File in the top left of your screen. 
 

 
 

 Password enables the user to change his or her password.  For security purposes, it is 
recommended that this is done regularly. 

 Change User should be used to ensure that each person accessing Integris does so under 
their own user name and with their personal levels of access. 

 Lock Terminal may be used if the user needs to leave his or her computer temporarily, does 
not want to log off and does not want to allow access to anyone else.  Unlocking the terminal 
requires the user to enter his or her password again. 

 Report Destination allows the user to choose where to send any report created in Integris.  
The options are displayed below. 

 
 

Activity: The File Menu 

Top Toolbar > File 

View each of the following items in the File menu: 
 

 Password 

 Change User 

 Lock Terminal 

 Report Destination 
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2 Accessing Help 

Activity: Accessing Help 

Top Toolbar > Help > Help Contents and Index 

 Click Help in the top toolbar 

 Select Help Contents and Index 
 

 
 

 Highlight Integris RM Billing Help 

 Click Help 

 View the manual  

 Close the manual and Help 
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Activity: Logging onto RM Finance 
 
All RM Billing Users must log onto RM Finance before any processing can be undertaken. 

RM Billing > Students  

 Select User Name Manager Corporate Services 

 Enter password keys 
 

 
 

 Click on  
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3 Brief Overview of RM Billing 

3.1 Students 

The Students section is the ‘heart’ of the RM Billing module. When the window opens all students 
on the current roll are displayed along with their current year group and current form. 
 

 

3.1.1 Student Icons 

The following icons are available on the Student List screen. 
 

 
Standard Student Find Tool 

 
Load Current Students – Displays all students on the current roll 

 
Open Details – Opens the drill down facility for the selected student 

 
Print – Prints all students displayed in the list view 

 
Print Selected – Prints all selected (highlighted) students in the list view 

 
Hide Selected – Hides all selected students 

 
Hide Unselected – Hides all unselected students 

 
Show/Hide Deleted Students – Displays students who have been deleted from 
the Administration module but still have a record in RM Billing 
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3.1.2 Using the Student Window Icons 

Activity: Using the Student Window Icons 

RM Billing > Students 

 Click Find Student  

 Select Year Group 6 to display only the Year 6 students 

 Click Find > Select > Yes 

 Click Load Current Students  to display all students who are on the current roll 

 Highlight any student and select Open Details  

 Click Return to View  
 

 Click Print List  

 Click OK to print to screen  

 Close the Student Summary Report 
 

 Hold <Ctrl> and select 5 students from the list 

 Click Print Selected  

 Click OK to print to screen 

 Close the Student Summary – Selected Items Report 
 

 Click Hide Selected  to hide those selected students 

 Hold <Ctrl> and select 5 students from the list 

 Click Hide Unselected  to only view those selected students 

 Click Load Current Students  to display all students who are on the current roll 

 Double click on the Notes header 

 Highlight the students with Notes 

 Click For Selected > Print Notes and OK 
 

 
 

 View and close the notes screen 
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3.1.3 Quick Search on Student Surname 

A quick search on student surname is available on this window. For example, if you click on the 
first student in the list and then type the letter ‘B’ the cursor will move to the first student whose 
surname begins with ‘B’. If you type the entire surname (e.g. BORN), the first student in the list with 
that surname will be highlighted. 
 

3.1.4 Drill Down Facility 

Drill down functionality is instigated by double-clicking or pressing <enter> on a student name. 
Note that all transactions will be attached to the student’s record. The name of the fees biller is 
also attached to this record. 
 

3.1.5 Red Fields 

The red fields at the top of the screen are scroll fields and search fields.   

 Left mouse click to view the next student.  

 Shift and left mouse click to view the previous student.     

 Right mouse click to enter the name of a new student to view.   

 It is recommended that users work with smaller groups of students and this method is used 
to navigate between students. 

 

 

Note: It is advisable (and quicker) to search for students from within the drill down section 
rather than always returning to the front screen. Either the red fields or the binoculars can 
be used. 

3.1.6 Return to View 

Use the blue circular arrow   to return from the drill down display to the front list screen.   
Selecting return to view will recalculate student balances.    
 

Activity: Searching for Students 

RM Billing > Students 

 Type the Surname Avery 

 Double click Charmaine Avery 

 View the tabs available in the student window 

 Right click in the Surname field and type ANDREWS then press<Enter>. The first student 
with that surname is displayed 

 Close the Student details window 
 

Note: The student details window will be used in depth later in training. 
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3.2 Customers 

This section is used to bill customers who are external to the school (i.e. not 
parents/guardians/students). For example the local theatre group who wish to hire the school hall 
for their rehearsals. 
 
Customer records can be created at any time by the user.  
 
The functionality available in the Customers section is very similar to the functionality available in 
the Students section. 
 

 
 

3.2.1 Customer Icons 

The following icons are available in the Customers section. 
 

 
Load All – Displays all customers in the list view 

 
Open Details – Opens the drill down facility for the selected customer 

 
Print – Prints all customers displayed in the list view 

 
Print Selected – Prints all selected (highlighted) customers in the list view 

 
Hide Selected – Hides all selected customers 

 
Hide Unselected – Hides all unselected customers 

 
Add Customer – Allows a customer record to be added 

 
Edit Customer – Allows a customer record to be edited (restricted editing only if 
there are transactions against the customer) 

 
Delete Customer - Allows a customer record to be deleted (only if there are no 
transactions against the customer) 
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3.2.2 Quick Search on Customer Name 

A quick search on Customer Name is available on this window. For example, if you click on the first 
Customer and then type the letter ‘B’ the cursor will move to the first Customer whose name begins 
with ‘B’. If you type the entire Customer Name then that Customer Name will be highlighted.   
 

3.2.3 Drill Down Facility 

Drill down functionality is instigated by double-clicking or pressing <enter> on a Customer Name. 
 

3.2.4 Red Field 

The red field at the top of the screen is a scroll field and a search field (see Students section). 
 

3.2.5 Return to View 

Use the blue circular arrow   to return from the drill down display to the front list screen. 
 
 

3.3 Billing Items 

This section is used to create Billing Item batches. These batches will hold the billing item 
transactions once the students have been billed. The standard icons which have already been 
discussed are available on this window. 
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3.4 Receipts 

The Receipts section is used to create Receipts batches. These batches will hold the receipts 
entered into RM Billing. The standard icons which have already been discussed are also available 
on this window. 
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3.5 Reports 

A variety of standard reports are available from this section as illustrated below. These will be 
covered as we progress through the training course. 
 

  



 

 
RM Billing Prim Receipts Training Notes 2019 31/12/18  

Page 20 of 90 

   © 2019 Civica Education Pty Ltd 

 

 

3.6 Parameters 

Parameters can be set to customise the RM Billing module for use in your school. More detail will 
be provided on the relevant parameters during the course of this training. 
 

 
 

3.7 Utilities 

The Utilities section provides a set of standard routines/processes that need to be run at certain 
times within the RM Billing module. These will be covered later in training. 
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4 Receipting 
All receipts entered into RM Billing must be placed into a receipts batch.  Receipts batches must 
be created before the receipts are entered.   
 
The following conventions should be followed when creating receipts batches.    
 

4.1 Separate Receipts Batches 

Create separate batches for the following options: 
 

 General Banking (daily takings – cash and cheques) 

 Electronic Funds Transfers which include electronic credit card payments 

 Direct Deposits, such as payments from Centrelink or Family and Children’s Services 

 BPAY 

 Corrections (Reversals) 

 Refunds 

 Government Subsidies (special type of receipt – not exported) 
 
It is important that you separate the different types of receipts. This will make reconciliation in RM 
Finance much easier.  
 
For example, a general banking batch containing Cash and Cheques should be closed off when 
you are ready to bank the money. Then the batch total in RM Billing (which is transferred to RM 
Finance) will match the deposit amount you take to the bank. When you reconcile in RM Finance, 
the same batch total will appear on the bank statement and also in RM Finance making it easy to 
reconcile.  
 
If you enter other types of receipts into the batch which are not banked your batch total in RM 
Billing and RM Finance will not match what is on the bank statement. 
 

4.2 Naming Receipts Batches 

The Receipts batch number will be automatically created by RM Billing. It will always begin with the 
letter ‘B’ followed by a sequential 5 digit number beginning with 00001.  
 
When naming a receipts batch the description should contain the type of batch and the date it was 
created (dd.mm.yy). 
 
For example: 
General Banking 18.02.19 
Electronic Funds Transfer 18.02.19 

Note:  For receipts entered retrospectively from receipt books or Z tapes enter the comment 
“Duplicate- original receipt #xxxx” or “Duplicate-original Z tape #xxxx” as required   

Note:  For more information log on to http://det.wa.edu.au/finance/detcms/portal/  to access 

“Procedures for RM Billing Receipts batches. 

  

http://det.wa.edu.au/finance/detcms/portal/
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4.3 Receipt Payment Types 

The following standard payment types exist in RM Billing and need to be used when entering 
receipts onto the system. 
 
CA  Cash 
CH Cheque 
CR Credit Card 
EF EFTPOS 
BP BPAY 
DD Direct Deposit 
GV Government Subsidies 
 
 

4.4 Methods of Receipting 

There are a number of different methods that can be used for entering receipts into RM Billing.  
The method used will depend upon the circumstances. 
 

4.4.1 Receipting Methods 

There are four methods users may select from when processing receipts.  Each has features to 
assist users with individual receipting needs. 
 

Receipt 
Process 

 Features Type of Payment 

Apply Receipt Students>For Selected>Apply 
Receipt 

Payment is 
automatically 
allocated to billing 
items 

CA, CH,CR,EF,BP,DD 

Add Receipt Student Record>Add Receipt Payment is 
automatically 
allocated to billing 
items.  Users may 
edit allocations. 

CA, CH,CR,EF,BP,DD 

Bulk Receipts Receipts>Receipt batch>Bulk 
Receipts 

Allows users to 
receipt via 
payment type. 
Users select the 
billing items to be 
paid. 

CA, CH,CR,EF,BP,DD, 
GV 
 
Ensure correct payment 
batch type is selected 

Add  
Receipt for 
selected Billing 
Items 

Billing Items> Batch Billing 
Items> Show Outstanding 
Balances> Add Receipt 

Allows users to 
receipt payments 
of the same billing 
item, amount and 
payment method. 

CA, CH,CR,EF,BP,DD 
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Activity: Creating a Receipts Batch 
 
Create the following two receipts batches using today’s date. 
 

 General Banking dd.mm.yy 

 Electronic Funds Transfer dd.mm.yy 
 

RM Billing > Receipts 

 Click Add Item  

 Enter the description and today’s date 
 

 
 

 Click OK 
 

 Create an Electronic Funds Transfer Receipts Batch using the instructions above 
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4.4.2 Bulk Receipting for the same Billing Item (via the Billing Items batch) 

This method is useful if a group of students are all paying the same amount for the same billing 
item(s).  For example, a group of students are all paying $250 for their Camp Charges. 
 
The Payment Type (e.g. Cash or Cheque) must also be the same for each group entered. 
 

Activity: Entering Bulk Receipts for the same Billing Item 
 
The following students have all paid in full for their Camp Charges. Follow the instructions below 
to enter these receipts in bulk via the Billing Items batch. 
 

Name Payment Type Amount Paid 
 

Kate Ellard CHEQUE 250 

Keith Jones CHEQUE 250 

Tamara Murphy CHEQUE 250 

Total Amount Paid 750 

 

RM Billing > Billing Items 

 Double-click on the Year 6 Camp batch 

 Click on the Batch Billing Items tab 
 

 Click  (this ensures that the balances owing on the billing items 
after adjustments, if any, are displayed) 

 

 Click on the Student/Cust column to sort alphabetically 

 Highlight all the billing items for the students who have paid in full 
 

 Check the Selected Totals Amount. This should match the total expected of 750.00 
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Note: The Selected Totals amount must match the total amount being receipted. 

 Click Add Receipts  

 Press <Tab> and select the General Banking batch 

 Press <Tab> to the Amount and enter 750 (this is the combined total) 

 Enter the payment type of CH for Cheque or press <Tab> for a list 

 Enter a comment (e.g. Year 6 Camp) 
 

  
  

 Click OK 
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 Click Yes 
 

 Select Receipts and click OK 
 

 
 

 Click OK to print to screen 

 View and close the receipts 
 

 

To print receipts at another time:  

 Choose Students  

 Select the appropriate student 

 Choose the Receipts tab 

 Select the appropriate receipt in the top half of the window 

 Choose the Printer icon  
 

Activity: Review of Entering Bulk Receipts for the same Billing 
Item 
 
Use the same method to enter the receipts for those students who have paid by Cash for the 
camp. Print the receipts to the screen. 
 

Name Payment Type Amount Paid 
 

Mark Mills CASH 250 

Mason Richards CASH 250 

Josh Tep CASH 250 

Total Amount Paid 750 
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4.4.3 Entering Bulk Receipts for Charges and Contributions (via Apply Receipts) 

RM Billing > Students > For Selected 

This method is useful if a group of students are all paying the same amount for charges and 
contributions.  The system will automatically allocate the entered amount to each student to pay 
off their Billing Items in a specified order, according to regulations.  If the amount of the receipt is 
greater than the amount owing for the specified categories, then the additional amount will become 
unallocated credit (i.e. a credit amount which not assigned to any billing items). 
 
Billing Items will be paid off in the following order:   
 

Student Billing Category Priority for applying receipts 

Kindergarten, Pre-Primary, 
Primary, Secondary (Vol,Chg) 

Charges, Residential, Voluntary, Other Optional Costs 
and Voluntary Approved Requests followed by any 
other item which has a category assigned including 
Not Applicable.   

Secondary (Chg) Charges, Residential, Other Optional Costs and 
Voluntary Approved Requests followed by any other 
item which has a category assigned including Not 
Applicable. 

Temporary Visa Overseas 
Students 

Temp Visa, Charges, Residential, Other Optional 
Costs, Voluntary Approved Requests followed by any 
other item which has a category assigned including 
Not Applicable. 

Adult Students Adult Student Fees, Charges, Residential, Other 
Optional Costs and Voluntary Approved Requests 
followed by any other item which has a category 
assigned including Not Applicable. 

Full Fee Paying Overseas 
Students 

Charges, Residential, Other Optional Costs and 
Voluntary Approved Requests followed by any other 
item which has a category assigned including Not 
Applicable. 
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Activity: Entering Bulk Receipts for Charges and 
Contributions (via Apply Receipts) 
 
The following students have all paid $40 for their Charges and Contributions. The payments 
have been processed via EFTPOS.  Enter receipts for the student payments in the table below.   
 

Student Payment 

Luke Andrews 40.00 

Charmaine Avery 40.00 

Reuben Baker 40.00 

RM Billing > Students 

 Highlight the students listed in the table above 

 Click  Hide Unselected 

 Highlight the 3 students 
 

 
 

 Click For Selected > Apply Receipts  

 Press <Tab> and select the Electronic Funds Transfer receipts batch 

 Press <Tab> to the Amount and enter 40.00 (the amount that will be applied to each student) 

 Press <Tab> and select the payment type of EF 

 Enter a comment (e.g. Charges and Contributions) 
 

 
 

 Click OK 

 Close the Students window 
 

 

IMPORTANT:  
The amount entered will be applied to each student record.  Therefore, 

this functionality can only be used when each student has paid the 
same amount. 
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4.4.4 Printing receipts for items which have been receipted in bulk 

Receipts can be printed via the receipts batch for items which have been receipted in bulk. 
 

Activity: Print Receipts for Bulk Entries 
 
Print receipts for Luke Andrews, Charmaine Avery and Reuben Baker for the payment for their 
Charges and Voluntary Contributions. 

RM Billing > Receipts 

 Double-click on the Electronic Funds Transfer batch 

 Choose the Batch Receipts tab 

 Highlight the receipts to be printed in the top window 
 

 
 

 Click Print  
 

 
 
 

 Click on Yes 
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 Select Receipts and click OK 
 

 
 

 Click OK to print to screen 

 View and close the receipts 
 
 

 
 
 

Activity: Review of Entering Bulk Receipts via Students 
 
1. The following students have all paid $40 for their Charges and Contributions. The payments 

have been processed via cheque.  Enter receipts for the student payments in the table 
below.   

 

Student Payment 

Penelope Allen 40.00 

Ross Barbour 40.00 

Tanya Born 40.00 

 
 
2. Print Receipts for these students. 
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4.4.5 Bulk Receipting for a mixture of items via the Receipts batch 

This method is useful for inputting a group of receipts which are mixed in nature. For example, 
different students are paying different amounts with various payment types for different items. 
 

Activity:  Entering Bulk Receipts for a Mixture of Items 
 
The following payments have been received. They are mixed in nature. Enter these receipts via 
Receipts > Bulk Receipts.  Print receipts for the students. 
 

Name Amount 
Paid 

Payment 
Type 

Payment For 

Kyle Amber $10 Cash Year 2 Incursion 

Benn Kinnane $40 Cheque Pre-Primary Voluntary Contributions 

Elizabeth Williett $20 Cash Year 4 Zoo Excursion 

Doyen Bailie $40 Cheque Primary Voluntary Contributions 

 

RM Billing > Receipts 

 Double-click the General Banking receipts batch 

 Select the Bulk Receipts tab 

 Click Add  

 Enter the student’s surname (or part thereof) in the Student Name field and <Tab> to select 
the student from a list 

 Enter the amount and press <Tab> 

 Press <Tab> in the items field 

 Highlight the items to be paid, click OK and press<Tab> 

 Enter the Payment Type (or <Tab> for a list) and press <Tab> to the comment field 

 Enter a Comment (i.e. Incursions), then press <Tab> to move to the next line  

 Repeat this process using the table above  
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 Click OK 

 Click Print   

 Select Receipts and click OK 
 

 
 
 

 Click OK to print to screen 

 View and close the receipts 

 Click Return to View  
 

Note: If you create a blank line and need to remove it, perform a right mouse click on the 

blank line. You will then be given the option to remove the line.    

 

IMPORTANT  

The receipts are not saved until the OK button at the bottom of the 
screen is clicked. It is therefore recommended that shorter lists are 

entered and saved regularly to minimise loss of data in the event of a 
power failure etc. 
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Activity: Review of Entering Bulk Receipts for a Mixture of 
Items 
 
1. The following payments have been received. These payments were all received via EFTPOS 
therefore they must be entered into the Electronic Banking receipts batch.  Enter these receipts 
via Receipts > Bulk Receipts. 
 

Name Amount Paid Payment 
Type 

Payment For 

Cassie Brood $75 EFTPOS Balance of account 

Haley DeSilva $250 EFTPOS Year 6 Camp 

Tamara Allen $55 EFTPOS Primary Voluntary Contributions &  
IPad Replacement Fund 

 
 
2. Print receipts for these students. 
 

 Click on Return to View  
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Activity: Receipting Overpayments 
 
Steven Brown wishes to pay $325.00 in cash for his Charges and Contributions.  Currently his 
Billing Items total $75.00.  The overpayment will be processed as unallocated credit. 

RM Billing > Receipts 

 Double click on the General Banking Batch receipts batch 

 Select the Bulk Receipts tab 

 Click Add Receipts   

 Type Brown and press <Tab> to select Steven 

 Type 325.00 in the amount 

 Press <Tab> in the items field and select all items  
 

 
 

 Click OK 
 

 
 

 Click Yes 

 Press <Tab> in the Type column and select CA 

 Type in comment Charges and Contributions 
 

 
 

 Click OK 
 
 

Note: The overpayment will be recorded as unallocated credit within Steven Brown’s 
record.  The amount will be posted against the Billing Suspense Account N3199 in RM 
Finance. 
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4.4.6 Individual Receipting  

This method can be used to enter a receipt for an individual student.  

Activity: Entering an Individual Receipt 
 
Mr James Elliott, Katherine Elliott’s grandfather wishes to pay with a cheque for $40 for her   
Voluntary Contributions.  Enter the receipt into RM Billing. 

RM Billing > Students 

 Double-click on the record for Katherine Elliott 

 Select the Receipts tab 

 Click   

 Press <tab> for a list of open receipts batches 

 Select the General Banking batch for today 

 Press <tab> to move to the Payment Type field 

 Press <tab> for a list of valid payment types (or type the code if you know it) 

 Select Cheque 

 Enter $40 as the amount and press <tab> 

 Enter a comment (e.g. Voluntary Contributions) 
 

 Edit the title to read: Mr 

 Edit the First Name to read: James 

 Edit the Address to 54 Lois Lane 
 

 
 

 Click OK to save 
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Note: The ‘Received from’ fields on the Add Receipt screen show the name of the current 
fees biller for the student. If someone else is paying the money, these fields should be 
edited to contain the name and address of that person. These details are saved with the 
receipt. 

4.4.7 Printing an Individual Receipt 

Activity: Printing an Individual Receipt 
 
Print a receipt for Katherine Elliot for her payment of Voluntary Contributions. 
 

 Highlight the receipt on the Receipts tab for Katherine Elliot 
 

 
 

 Click Print   

 Select Receipts, click OK 
 

 
 

 Click OK to print to the screen 

 View and close the Receipt 

 Click Print   
 

 Select Record of receipt allocations 

 Click OK 

 Click OK to print to the screen 

 View and close the Record of receipt allocation 
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Notes: The official document is the ‘Receipt’. This is what should be printed and given to 
the parent.  

The ‘Record of Receipt Allocation’ can also be printed if required. This lists the billing items 
to which the receipt is currently allocated. Note that the allocations for a receipt can change 
if paid billing items are reversed or adjusted or if unallocated credit is allocated. 

 

4.4.8 Original/Draft/Copy text on Receipts 

To obtain an original receipt, the receipt must be printed directly to the printer (not to the screen 
and then to the printer). 
 
Receipts printed directly to the printer for the first time will contain no additional text. 
Receipts viewed to the screen will contain the text ‘DRAFT’. If sent to the printer from the screen, 
the printed copy will contain the text ‘DRAFT’. Receipts printed to the printer for the second or 
subsequent time will contain the text ‘COPY’. 
 
The above is an important audit consideration as there should only ever be one original receipt 
created. 
 
 
 

4.4.9 Entering an Individual Receipt for more than one billing item 

Activity: Enter Individual Receipts for a Number of Billing 
Items 
 
Troy Dean has $50 cash to pay for his Voluntary Contributions and Incursions.  Enter and print a 
receipt and receipt allocation for Troy. 

RM Billing > Students 

 Right click in the red surname field 

 Type in Dean and Enter  
 

 Select the Receipts tab 
 

 Click   
 

 Press <Tab> in the Batch No. field and select the General Banking Receipts Batch click OK 

 Press <Tab> in the Payment Type and select Cash press <Tab> 

 Enter 50.00 in the Amount <Tab> 

 Enter the Comment Primary Voluntary Contributions and Incursion 
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 View the Applied column and notice that the payment has been automatically applied from 
the top down and is against the IPad Replacement billing item 

 

 
 

 Delete the 10.00 that has been applied to the IPad Replacement billing item 

 <Tab> down to the Incursions billing item 

 Enter 10.00 in the applied column <Tab> 
 

 
 

 Click OK 
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 Highlight the new receipt 

 View the details of the receipt in the lower details section of the screen 
 

 
 

 Click Print   

 Select Receipts, click OK 
 

 
 
 

 Click OK to print to the screen 

 View and close the receipt 
 

 Click Print   

 Select Record of receipt allocations 

 Click OK 

 Click OK to print to the screen 

 View and close the record of receipt allocations 
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Activity: Review of Entering Individual Receipts 
 
1. Conan Rogers has brought a cheque for $55 to pay for his Voluntary Contributions and IPad 

Replacement Fund.  Enter and print a receipt for Conan. 
 
 
 
 
2. Nora Chum has brought $250 cash to pay for the Year 6 camp.  (Hint: you will need to 

change the allocation of the receipt). Enter and print a receipt for Nora. 
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4.5 Receipting for Customers 

Individual receipts can be created for a particular customer. This is done via the Customers section 
by drilling down on the Customer record and going to the Receipts tab. 
 

Activity: Add a Customer Receipt 
 
West Coast Theatre has paid in full for the hall hire.  The money has been paid directly into the 
bank using EFTPOS via the schools on-site machine.  Print a copy of the receipt for West Coast 
Theatre. 

RM Billing > Customers 

 Double click on West Coast Theatre 

 Select the Receipts tab 

 Click Add Receipt  

 Press <Tab> in the Batch No field and select the Electronic Funds Transfer batch 

 Enter the payment type of EF or <Tab> for a list 

 Accept the default date 

 Enter the amount of 550.00 

 Enter a Comment (e.g. Hall Hire Term 1 Weeks 1-5) 

 Check that the applied amount is correctly allocated in the lower window 
 

  
 

 Click OK 

 Highlight the receipt and click Print  
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 Select Receipts and click OK 
 

 
 

 Click OK to print to screen 

 View and close the receipts 

 Close the Customer Details window  
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4.6 Reporting on Receipts 

4.6.1 The Daily Banking Summary 

This report is useful in reconciling the daily takings. It will separate the transactions by payment 
type (e.g. Cash and Cheque) and give overall totals 
 

Activity: Print the Daily Banking Summary 
 
Print the Daily Banking Summary for the General Banking receipts batch for today. 

RM Billing > Receipts 

 Highlight the General Banking receipts batch 

 Click For Selected > Print Daily Banking 

 View and close the Daily Banking report 
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4.6.2 The Receipts Summary Reports 

This report will group all receipt allocations by analysis code, budget code and GST code.  It is a 
mandatory report and must be printed and filed. 
 

Activity: Print the Receipts Summary 
 
Print the Receipts Summary – Detailed Report for the General Banking receipts batch for today. 

RM Billing > Receipts 

 Highlight the General Banking receipts batch 

 Click For Selected > Print Receipts Summary 

 Click OK to print to the screen 

 Click Yes to print the Detailed Summary 
 

 
 
A portion of the report is displayed below 
 

 
 

 View and close the Receipts Summary Detailed Report  
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Note: The Daily Banking and Detailed Receipt Summary Reports are mandatory reports 
and must be printed and signed by the Principal as part of the batch closing routine and 
for End of Month Reporting. 

Print the Totals Only Report. 
 
The Totals Only Report is recommended for the manual input of receipts into RM Finance 
 

 Highlight the General Banking receipts batch 

 Click For Selected > Print Receipts Summary 

 Click OK to print to the screen 
 

 
 

 Click No to print the Totals only report 
 

 
 

 View the Totals only report and close 

Note: This report shows the amounts to be exported to RM Finance if the school is using 
the Export functionality. If not exporting, the report is used as the source document for 
manual data entry into RM Finance. 
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4.7 Preparing to Export a Banking Batch 

Activity: Printing the Daily Banking Summary 
 
We have finished entering the transactions from the Electronic Funds Transfer Report and are 
now ready to close that batch.  The General Banking batch will be left open as we may receive 
some more payments before we are ready to close it and bank the proceeds. 
 
Print the Daily Banking Summary for the Electronic Funds Transfer receipts batch for today. 

RM Billing > Receipts 

 Highlight the Electronic Funds Transfer receipts batch 

 Click For Selected > Print Daily Banking 

 Click OK to print to screen 
 

 
 

 View and close the Daily Banking Summary 
 

Note: The Daily Banking Summary must be printed and filed for reference. 
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Activity: Print the Receipts Summary 
 
Print the Receipts Summary for the Electronic Funds receipts batch for today. 

RM Billing > Receipts 

 Highlight the Electronic Funds receipts batch 

 Click For Selected > Print Receipts Summary 

 Click OK to print to screen 
 

 
 

 Click Yes to print the Detailed Report 
 

 
 

 View and close the Detailed Receipts Summary Report  
 

Note: The Detailed Receipt Summary is a mandatory report and must be printed and signed 
by the Principal as part of the batch closing routine and for End of Month Reporting. 



 

 
RM Billing Prim Receipts Training Notes 2019 31/12/18  

Page 48 of 90 

   © 2019 Civica Education Pty Ltd 

 

4.8 Exporting a Receipts Batch 

Activity: Export the Receipts Batch 
 
Once processing is completed, the Daily Banking Summary and the Receipts Summary Detailed 
report are printed the batch can be exported to RM Finance. This process will automatically 
close the batch and mark the transactions as posted.  

RM Billing > Utilities 

 Double click Export to RM Finance 
 

 
 

 Click Yes 

 Highlight the Electronic Funds Transfer Batch 
 

 
 

 Click OK  

 Check the settings on the Print Setup screen and click OK (do not Cancel at this stage, 
otherwise transactions will not be exported).  
 

 
 

 Click OK once the Export is Complete 

  

As a batch has been exported, it is automatically closed, so a new Electronic Funds Transfer 
batch will need to be created to hold the next day’s takings. 
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The Receipt Batch Export Summary is displayed below. 

Note: The Receipts Batch Export Summary Report will be printed. Ensure this report is 
kept for End of Month reporting. This Report can be re-printed from RM 
Billing>Reports>Audit Reports if required. 
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5 Correcting Errors/Making Adjustments 
The table below outlines the different adjustment options which are available for billing items and 
receipts.  
At times it may be necessary to correct an error made when entering a billing item or a receipt. 
Alternatively it may be necessary to make some type of an adjustment to a billing item or a receipt 
due to a change in circumstances. 
 

Billing Items Receipts 

Reversal This will create an opposite 
(reversal) transaction thereby 
‘cancelling out’ the billing item.  
 

 Used to correct an error 
(billing item should not have 
been created) 

 Used when a student should 
no longer be charged for an 
item (e.g. billed for Camp but 
now not going) 

Reversal This will create an opposite 
(reversal) transaction thereby 
‘cancelling out’ the receipt 
 

 Used to correct an error 

 Used for cheques that are not 
cleared 

 Used for EFTPOS payments 
that have failed 

 
(Note that Billing item balances will 
be reinstated.) 
 

Adjustment This will create an adjustment 
transaction for the amount 
entered. This reduces the amount 
of the billing item by the adjusted 
dollar amount.  
 
Note: An alternative method could 
be to reverse the item and then 
add a new billing item which can 
be edited for a lower amount. 
 

Refund Used to refund amounts that have 
already been paid. 
 

 Used when money needs to be 
returned (refunded) to the 
parent. 

 
 
The associated billing items will be 
reversed automatically so that the 
debt is not reinstated. 

Write-Off This will create an opposite write-
off transaction to negate the 
amount still owing on the billing 
item thereby ‘cancelling out’ the 
billing item. 
 

 Used at the end of the year to 
write-off debts that will not be 
recovered (in accordance with 
the Department’s write-off 
policy) 
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6 Receipt Reversals 
 
A receipt can be reversed for a number of reasons.  If the original batch the receipt was processed 
into has been closed, then an alternative batch must be created to either hold the receipt or pass 
the receipt through to another record.  If a receipt is to be refunded and the original batch has been 
closed, then a Refunds batch must be created to hold the reversed receipt. 
 
 
The Corrections Batch 
 
A Corrections batch would be created if the original batch the receipt was processed into has been 
closed and a receipt reversal is to be performed.  This could be because of user error resulting in a 
receipt having to be reversed, or perhaps a cheque has been dishonoured by the bank, or a receipt 
has been applied against a wrong student record and therefore must be reversed and applied to 
the correct student. 
 
 
The Refunds Batch 
 
A refunds batch would be created if money which has been paid, needed to be returned (refunded) 
to a parent/guardian.  Refund batches must be identified according to the type of Refund eg: EFT, 
System Generated cheques or Manual written cheques.  If processing EFT refunds, the batch 
would be named Refunds – EFT dd/mm/yy etc. 
 
Unlike a General Banking batch or an EFT batch which may stay open until the banking is ready to 
be finalised, both the Corrections and the Refunds batches are closed as soon as the Correction or 
Refund has been completed. 
 
 
Non Exporting Schools 
 
Schools which are not exporting to RM Finance may write manual cheques or produce system 
generated cheques which can be created when the expenditure transaction is entered into RM 
Finance. 
 
 
Exporting Schools 
 
Schools which are exporting to RM Finance have the option of refunding through a Manual 
cheque, a System Generated cheque or through EFT.  This functionality is only available for 
students at this time and not for Customer refunds.  Customer refunds can only be made through a 
manual written cheque. 
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Activity: Create Correction and Refund Batches 
 
West Coast Theatre has informed us that the Hall is unsuitable and have requested a refund to 
which we have agreed and will issue them with a manual cheque  
 
We have also received a call from Ms Chum to say that Nora is unable to attend the Year 6 
camp and have agreed to issue her with a refund via a system generated cheque 
 
We have also been advised that Elizabeth Williett has broken her leg and cannot attend the Year 
4 Perth Zoo Excursion and would like a refund via EFT. 
 

 Create 3 Refunds batches for the following: 
 

o Refunds – Manual Cheque (WCT) dd/mm/yy 
o Refunds – System Cheque (Nora Chum) dd/mm/yy 
o Refunds – EFT (Elizabeth Williett) dd/mm/yy 

 
RM Billing > Receipts 
 

 Click Add Item  
 

 
 

 Click OK 
 

 Click Add Item  
 

 
 

 Click OK 
 

 Click Add Item  
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 Click OK 
 
 

 
It has also been discovered that a $40 Electronic Funds Transfer payment processed against 
Reuben Baker should have been processed against Tareq Becker.  A Corrections batch must be 
opened to process the receipt from Reuben Baker to Tareq Becker 
 
Create the following receipt batch using today’s date. 
 
Corrections dd/mm/yy 
 

 Click Add Item  
 

 
 
 

 Click OK 
 

 The batch numbers are recorded on the Finance Batch Register 
 

 
 

 Close the Receipts window 
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Activity:  Reverse a Receipt 
 
Reverse the receipt from Rueben Baker and apply the receipt to Tareq Becker 

Note: As the Electronic Funds Transfer batch used to process this transaction is closed, 
these transactions are processed using a Corrections batch. 

RM Billing > Students 

 Double click on Reuben Baker 

 Select the Receipts tab 

 Highlight the $40 receipt 
 

 
 

 Click   
 

 
 

 Click Yes 

 Enter a reason for the reversal (i.e. Error – should have been applied to Tareq Becker) 
 

 
 

 Click OK 
 

 Select the Corrections batch 
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 Click OK 
 
View the reversal transaction 
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Activity:  Re-enter the Reversed Receipt 

RM Billing > Students 

 Right click into the red Surname cell 

 Enter Becker 

 Press <Tab> 

 Select the Receipts tab 

 Click on  

 Press <Tab> in the Batch Number 

 Select the Corrections Batch 

 Press <Tab> in payment type select EF 

 Enter amount of $40 

 Enter comment Charges and Contributions 
 

 
 

 Click OK 
 

IMPORTANT 

Normally the revered receipt would be posted into the original open 
receipts batch, however if the original batch is closed, the receipt must 

be entered into the Corrections batch. 
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Activity: Print the Receipts Summary Report 
 
View the Daily Banking and Receipts Summary reports for the Corrections batch to see the 
reversal transactions. 
 
RM Billing > Receipts 
 

 Select the Corrections Batch 

 For Selected > Print Daily Banking 

 Click OK to print to screen 
 

 
 

 View and Close 
 

 For Selected > Print Receipts Summary 

 Click OK to print to screen 
 

 
 
 

 Click Yes to print the Detailed Summary report 
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 Close the receipts summary 

 Close the receipts window 
 

Notes:  Printing both of these reports are mandatory for all receipts batches. Corrections 
batch should be closed and either exported (or entered) into RM Finance to reflect 
changes of receipt allocation.  Due to time constraints we will not be doing this in 
training. 
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6.1 Student Refunds 

Activity:  Perform a Student Refund – System Cheque 
 
Nora Chum’s mother has contacted the school to say that Nora is ill and cannot attend the 
camp.  She has already paid and has asked for a refund to which the school has agreed.  A 
System Generated cheque will be issued to Ms Chum. 

RM Billing > Students  

 Double-click Nora Chum 

 Select the Receipts tab 

 Highlight the receipt to be refunded 
 

 Click  
 

 
 

 Select System Generated Cheque and OK 

 Enter the Refund Amount of 250 (Note:  Full or partial refunds can be entered) <tab> 

 Enter the first 3 letters of the surname CHU <Tab> 
 

 
 
Ms Chum has not been added as a supplier, so in order for the refund to be processed, her  
Details must be added to the supplier list. 
 

 Click OK to the message 
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 Click Add Record  

 Enter the following information 
 

 
 

 Click OK 
 

 
 

 Click OK 
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Cheryl Chum has now been entered as a  supplier and the refund process can continue 
 

 Click OK 

 Enter the Reason for the refund 
 

 
 

 Enter the Amount of the refund for each billing item in the ‘Adjust by’ column 

 Select the correct Refund Billing Code for Charges (press <Tab> in the ‘Ref Code’ field for 
a list) 

 

 
 

 Click OK 
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 Select the Refunds – System Cheque 
 

 
 

 Click OK 
 

 
 

 View the reversed receipt 

 Close the Student window 
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Activity: Perform a Customer Refund – Manual Cheque 
 
West Coast Theatre will not be using the Hall during Term 1.  They have asked for a full refund 
of their money to which the school has agreed. The manual cheque number is 123567. 

RM Billing > Customers  

 Double-click on West Coast Theatre’s record 

 Select the Receipts tab 

 Highlight the receipt to be refunded 
 

 
 

 Click  

 Enter the refund Amount of 550.00 

 Enter the Reason for the refund 

 Enter the Amount of the refund in the ‘Adjust by’ column 

 Select the correct Refund Billing Code for Facilities Hire (press <Tab> in the ‘Ref Code’ 
field for a list) 

 Enter the manual cheque number in the ‘Cheque Number’ field 
 

 
 

 Click OK 
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 Select the Refunds – Manual Cheque (WCT) 
 

 
 

 Click OK 
 

 
 

 View the Refund Transaction and Close the Customer Details window 
 

 

Notes: The Customer Refund screen does not have the facility to enter a name in the 
‘Refunded To’ section. The refund will automatically be recorded against the customer 
name which cannot change. 

Refunds of unallocated credit are processed using a System refund code of SUS 

Refund batches should be either exported or entered into RM Finance as the refund is 
processed.  We will not be doing this in training due to time constraints. 
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Activity:  Refund Via EFT 
 
Elizabeth Williett has broken her leg and will be unable to attend the Year 4 Perth Zoo 
Excursion.  Mrs Williett has given the school her bank account details for a refund via EFT. 
 
RM Billing > Students 
 

 Double click on Elizabeth Williett 

 Click on the Receipts tab 

 Highlight the receipt for the Year 4 Perth Zoo Excursion 
 

 
 

 Click  
 

 
 

 Select EFT and OK 

 Enter the Refund Amount of 20 

 <Tab> <tab> to bring up a list of suppliers 

 Scroll down and select Ms Patricia Williett 
 

 
 

 Click OK 
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 Enter the Reason for the refund <tab> 

 Enter the EFT Reference (this is the name or initials of your school) <tab> 

 Enter the Amount of the refund in the ‘Adjust by’ column <tab> 

 Select the correct Refund Billing Code 
 

 
 

 Click OK 

 Select the Refunds – EFT batch 
 

 
 

 Click OK 
 

 
 

 View the refund  
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7 Unallocated Credit and Payments in Advance 

 
If money has been receipted against a billing item and the billing item is reversed or adjusted, the 
money assigned to these items will become unallocated credit.   
 
If money is receipted before any billing items have been created then this money will become 
unallocated credit.   
It is not uncommon for schools to accept payments in advance for billing items that will occur 
during the year.  This may happen at the onset of a new year where schools will accept payments 
from parents/guardians for charges that will arise during the term or during the year.  These 
typically may be for charges and contributions, camps, excursions, incursions etc.  The payments 
received are held as unallocated credit until the billing items have been created, then once created, 
the money may be applied against the required billing item. 
 
Payments may be taken by schools at any time during the year or at the end of the year, for billing 
items that will arise in the new school year and will be held as unallocated credit. 
 
Unallocated credit can either be refunded or can be used to pay for other billing items for the 
student in accordance with the parent’s instructions. 
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Activity: Reverse Billing Items which have been paid 
 
Haley DeSilva is unable to attend the camp, but her parents have paid for it in advance. The 
money paid for the camp will become unallocated credit. 
 
Mr DeSilva rang to say that the camp money can be used to pay for any other amounts which 
are outstanding for Haley. Reverse the billing items for the camp. 

RM Billing > Students 

 Right Click in the Red Surname field  

 Enter DeSilva and <Enter> 

 Select the Billing Items tab 

 Highlight the first item for the camp 
 

 
 

 Click  
 

 
 

 Click Yes 

 Enter a reason for the reversal (e.g. Haley is unable to attend the camp) Hint: Ctrl/C to 
copy the reason and Ctrl/V to paste it for the remaining reasons 
 

 
 

 Click OK 

 Continue reversing the other two camp billing items 

 View the unallocated credit at the bottom of the student window 
 

 
 
 

 Click on   
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Note: Normally this credit would be allocated straight away, however for Training we want 
to view the credit in the Unallocated Credit Listing Report. 

 

 Close the student window 
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7.1 Locating Unallocated Credit Amounts 

A report can be produced to list all students and/or customers who have unallocated credit. 
 

Activity: Produce an Unallocated Credit Listing 

RM Billing > Reports 

 
Produce a report to view students who have unallocated credit 
 

 Open the Financial Reports folder 

 Select the Unallocated Credit Listing 

 Ensure Students is ticked 

 View the Sort options available 
 

 
 

 Click Print 

 Select OK to print to screen 
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 Close the report 

 Close the reports window 
 
 
 
 
Prior to the start of the academic school year, the following students paid in advance for their In 
Term Swimming lessons.  In accordance with the parent’s instructions, the amounts have been 
held as unallocated credit until the Billing Items were created and could then be allocated 
against the student’s record. 
 

Kurt Anderson Melissa Connell 

Zola De Mamiel Brenton Em 

Cain Kingston Jared Oliver 

 
 

Note: if the customer option is selected, the unallocated credit list will appear on a separate 
page of the report. 
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7.2 Allocating Unallocated Credit 

Activity: Allocating Unallocated Credit 
 
Mr DeSilva has advised that the credit created by reversing the camp billing items can be used 
to pay for other outstanding items. We will now allocate the unallocated credit. 

RM Billing > Students 

 Double-click Haley DeSilva 

 Select the Billing Items tab 

 Click on Show Billing Items with Outstanding Amounts 

 
 Only Billing Items with amounts to be paid are displayed 

 Highlight the billing items  
 

 
 

 Click  

 Enter the amount to allocate 
 

  
 

 Click OK 

 The $175.00 difference will be held as unallocated credit on the student’s account 

 Click on  
 

 
 

 Click on  

 Leave the student window open 
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Activity: Allocating Unallocated Credit 
 
Steven Brown has $250 of unallocated credit on his account.  We have been advised that he 
has been granted permission to attend the Year 6 Camp, so this can be used to pay for the Year 
6 camp billing items. 
 

 Right Click in the red surname cell. Enter Brown 

 Scroll to the records for Steven Brown 

 Select the Billing Items tab 

 Click  
 

 Highlight the  Year 6 Camp Billing Items 
 

 
 

 Click OK 
 

 Click on  
 

 Highlight the Camp Billing Items 
 

 
 

 Click  and allocate the full $250 
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 Click OK  
 

 
 

  Close the Student screen 
 

Notes: Reallocations of payments made in a batch which is now closed will be handled 
automatically by RM Billing. The previously closed batch will appear on the export list 
with an asterisk. 

School’s not using the Export Utility must print and post the Re allocation Transaction 
Report and enter the reallocations in RM Finance. 
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8 Auto Allocate Unallocated Credit 
Where there is more than one student with unallocated credit, it is possible to use the function 
‘Auto Allocate’ to automatically allocate unallocated credit to student’s billing items 
 

Activity:  Auto Allocate Unallocated Credit 
 
As several of the Year 3 students had their In Term Swimming lessons paid for in advance, the 
money paid has been held as unallocated credit.   As the school year has now commenced and 
the billing item created, we can use the Auto Allocate function to allocate the swimming money 
against each student’s record. They have all paid the $50 for Bus Hire and Pool Entry 
 
RM Billing > Billing Items 
 

 Double click on the Year 3 In Term Swimming billing item 

 Click on the Batch Billing Items tab  
 

 Click Show Outstanding Amounts  (this ensures that the balances 
owing on the billing items after adjustments if any, are displayed) 

 

 Click on the Student/Cust Header to sort alphabetically 

 Highlight the Swimming Pool Entry and Swimming Bus Hire lines for the following 
students 

      

Kurt Anderson Melissa Connell 

Zola De Mamiel Brenton Em 

Cain Kingston Jared Oliver 
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 Ensure the Selected Totals: Amount is $300 

 Click Auto Allocated credit to the selected billing items   
 

 
 

 Click Yes  
 

 
 

 Click OK 

 
 

 Go to the printer and check the report has printed 

 Click Yes 

 Click on the Balance header and view the Paid and Balances columns 
 

 
 

 Close the window 
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A report is sent straight to the Printer.  There is no option to print it to screen, however the Auto 
Allocation Report can be Re-Printed from the Reports Window. 
 
RM Billing > Reports 
 

 Open the Transactional Reports 

 Highlight Re Print Auto Allocate Transactions 
 

 
 

 Select the Report 

 Click Print 
 

 
 

 View and Close the Report 
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9 Following up Debt 

9.1.1 Printing Outstanding Billing Items from the Billing Items batch  

Activity: Print the Outstanding Billing Items Report 
 
There are a number of report available to identify outstanding Billing Items.  Print a list of 
outstanding billing items for the Year 4 Perth Zoo Excursion batch. 

RM Billing > Billing Items 

 Double-click on the Year 4 Zoo Excursion  batch 

 Click on the Batch Billing Items tab 

 Click Show Outstanding Amounts  

 Click Filter  
 

 Enter the following to highlight all items with a balance greater than (>) 0.00 
 

 

Note: Where multiple classes are attending an event you could also add the Form Room 
required as shown below. 

 
  

 Click on the Student/Customer heading to re-order alphabetically 
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The students who are highlighted still owe money for the Year 4 Perth Zoo Excursion 
 

 Click Print Selected  
 
This report will list individual billing items and the overall outstanding balance.  If a summary for  
tied Billing Item payments is required, then the Transaction Summary report can be printed. 
 
 

 View and close the report 

 Close the Billing Items window 
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9.1.2 Print the Transaction Summary Report  

Activity:  Print the Transaction Summary Report 
 
The Transaction Summary Report will display outstanding totals per student.  Print the 
Transaction Summary Report for all students who have not paid in full for the Camp. 
 
RM Billing > Reports 
 

 Open the Transaction Reports folder 

 Select the Transaction Summary 

 Select the Billing Items radio button 

 Click New Query 

 Use the Find tool to select the Year 6 students 

 Place a tick in the Student Totals Only box 

 Delete the default dates 

 Click on the Billing Options tab 

 Type and asterisk (*) in the Billing Item Batch field 

 Press <Tab> 

 Select the Year 6 Camp and OK 

 Place a tick in the Billing Item Balance box 

 Click on the equals sign (=) and select the > operator from the list 
 

 
 

 Click Print and OK 
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 View and Close the Report 
 

 Untick the Student Totals Only box 

 Print the report 
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10 Producing Statements 

10.1 Producing Statements for Students 

In RM Billing, an individual statement can be produced for each student.  Student statements can 
be accessed from two places:  
 

 Students > For Selected > Print Statement  

 Reports > Financial Reports > Statements-Students  
 

Activity: Print a Student Statement via the Student screen 
 
Produce a statement for all Kindergarten students. 

RM Billing > Students 

 Sort by Year group 

 Select all the Year K students 

 Click For Selected > Print Statement 

 Enter From date as shown below 
 

 
 

 The ‘From’ date will default to the first day of the current month. All transactions from this 
date onwards will be listed on the statement. Any transactions dated prior to this date will be 
summarised in an ‘opening balance’ figure. If this is the first statement you are sending to the 
parent/guardian then it is advisable to enter an earlier date so that all transactions for the 
current year are listed.  For training leave the default date 

 The ‘To’ date will appear blank but will default to today’s date if left blank. Otherwise an end 
date may be entered. Transactions dated after the ‘To’ date will not be included on the 
statement.  Leave this date blank for training 

 The default message that you entered in the Billing Parameters section will be displayed. 
This can be edited at this point if required but the changes will be used for this statement run 
only and will not be saved down.  Leave the default message for training 

 Click OK and print to the screen 

Note: This method can also be used to print statements for individual students. 
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 Scroll down the statements.  Note that discounts are displayed where they have been given 

 View the summary table at the bottom of each statement.  This will categorise ALL amounts 
outstanding, (regardless of the dates you may have entered for the date range), by billing 
year and category 

 Close the statements 

 Close the students window 
 

Note: When printing statements, print one or two and check that they are correct before 
printing for all students at once. Some printers may have problems coping with large 
quantities of statements at once). 
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10.2  Statements for Outstanding Debtors 

Statements can be produced for students with outstanding debt. 
 

Activity: Produce Statements for Outstanding Student Debtors 
 
Produce a statement for each student with outstanding debt. 

RM Billing > Students 

 Click on the Balance heading twice to bring those students with outstanding balances to the 
top of the list 

 Highlight the students with a balance > 0 

 Click Hide Unselected  

 Click on the Name heading to sort the students alphabetically by surname 

 Click on the Printer to print a list of all students receiving a Statement 

 <Ctrl> + A to select all the students 

 Click For Selected > Print Statement 
 

 
 

 Enter From date  

 Click OK 

 Click OK to print to screen 

 View and close the statements 

 Close the students window 
 

Note: At school Statements should be printed to Preview and a copy saved to the 
G:\Audit Reports\Student Statements folder prior to printing. A list of Students to whom 
Statements are being sent must also be printed, signed by the Principal and filed. 
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10.3  Producing a Reminder Unpaid Billing Items Report  

Activity: Print Reminder of Unpaid Billing Items Report 
 
Print a Reminder of Unpaid Billing Items Report for all Year 6 students. 

RM Billing > Reports 

 Open the Financial Reports folder 

 Select the Reminder Unpaid Billing Items 

 The Date range and the default message operate as described in the previous section 
 

 Click  

 Find and Select the Year 6 students 

Note: The default message set up in the Billing Parameters section is displayed. This may 
be edited if required, but the changes will only be for the current statement and will not 
change the original message set up in Billing Parameters. 

 

 Click Print 

 Click OK to print to screen 
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 View the displayed Reminder Unpaid Billing Items reports 

 Close the Reports and the reports window 

This Report can be used as an alternative to Statements, however, 
schools will still need to save a copy with their Audit Reports and 

Print a list of all students receiving a Reminder Notice. 
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11 Support 
Should you require support please contact the Customer Service Centre (CSC) at the 
Department of Education and Training. 
 
Contact details below: 
 

11.1 Phone (CSC) 

Metro: 9264 5555 
Country: 1800 012 828 
 
Please be prepared to supply your ID number, contact details and a brief description of the 
problem. 
 

11.2 Fax (CSC) 

9264 4701 
 
Please include your ID number, contact details and a brief description of the problem. 
 

11.3 Email (CSC) 

customer.service.centre@education.wa.edu.au 
 
Please include your ID number, contact details and a brief description of the problem. 
 

12  Online Manuals and Training Notes 

12.1 Civica Education 

Online manuals and training notes are available to download in PDF format from the Civica 
Education website. 
 
http://www.civicaeducation.com.au/ 
 
Select Integris Support. 
Log in to Western Australian SIS Schools. 
Username: school 
Password: help 
 

12.2 STIMS Project 

The Department’s Student Information Management Project (STIMS) website has numerous 
factsheets and support documents for all SIS Administration modules. 
 
http://www.det.wa.edu.au/intranet/stims  
 
Links to the Integris Manuals are also available from the STIMS website or by going to Help within 
Integris. 
 

mailto:customer.service.centre@education.wa.edu.au
http://www.civicaeducation.com.au/
http://www.det.wa.edu.au/intranet/stims
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13 Finance Web 

13.1 Department of Education – SIS Finance 

 
http://det.wa.edu.au/finance/detcms/portal/ 
 
Log on to the DET Portal to access the latest factsheets. 
 
RM Billing - Quick Reference Guide and FAQ 
RM Billing - Procedures for RM Billing Receipts Batches 
RM Billing - Using RM Billing _Alternative Method for Timetabled schools Yrs 8 -10 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

http://det.wa.edu.au/finance/detcms/portal/


 

DEPARTMENT OF EDUCATION AND TRAINING 

BATCH REGISTER 

     For the month of                                                                            Period      

     BANK RELATED TRANSACTIONS       

Batch 
No 

Date/Date 
Export 

Reference No   

Bank 
A/C 

1, 2, 3 

Income 
Receipts 

(INC) 

Expend 
Payments 

(ESP) 

Credit 
Notes 

Adjustments/Reversals ** 

Internal 
Charge** 

Accruals 
(Manual 

Only) 

BA/Vire 
Totals 

Proc 
By From To 

Type of  
Batch* 
[C] Cheque 
[E] EFT 
[B] BPay 

 

Income 
(I/C) 

Expend  
(ESC) 

          
  
         

               

               

                   

          
  
         

          
  
         

          
  
         

          
  
         

               

          
  
         

               

                  
  
  

  
          

                  
  
  

  
          

                

                

                

 

*Reversals and internal charges are not batched but must be recorded.  Billing batches are prefaced with a ‘B’.  Accruals are entered if manually 
processed. 


